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Glossary  

A: Ampere  

AC/DC:  Alternating Current / Direct Current  

Click:  Pressing the left button of the computer mouse with the cursor 

in a certain position. Right -click is pressing the right mouse 

button with the cursor in a certain area.  

.CSV: Coma separated values (data format that can be opened by a 

spreadsheet application ) 

DAD:  Diode Array Detector  

GUI: Graphical user Interface  

HPLC: High pressure liquid chromatography  

LED: Light Emitting Diode  

PID: proportional ðintegral ðderivative controller  

.tcf:  Time Control File  

USB: Universal Serial Bus  

UV: Ultraviolet  

V: Volt  
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1  Introduction  

As a preparative data and control system, SynthraView  meets all the 

requirements of up -to -date software in radiochemical chromatography and 

synthesis control. Its superior flexibility and modular construction means that 

the program can be adapted to suite any userõs requirements . Development of 

previous version of the program is that  SynthraView  has the additional 

advantages of a simple user interface and an improved method construction. 

All the advantages of networks (LAN) can be exploited without restrictions. 

National and international regulations (s uch as 21 CFR Part 11) are fully 

supported.  

The software allows isocratic elution of up to four solvents, gradient 

programming and gradient support. Switching valves, fraction collectors, 

heaters (reactor or column -oven) and syringe dosing pumps can be con trolled 

by time, threshold values or automatic peak sampling. Programming can be 

carried out in units of time, units of supplied solvent volume or in units of 

column volume.  

The screen is able to display the pump condition, flow rate, pressure, the 

solvent  being pumped, solvent supply, detector signals, temperatures and 

valve positions.  An entire synthesis run can be displayed in a visualization 

diagram of the  system that c an be individually formatted, and in a time control 

file that  indicates the stage in progress at all times.  

The screen keys and visualization diagram of the system allows manual 

control of the pumps and valves.  

During a synthesis, the functions of the time control file can be adjusted using 

a graphic time control editor. This allows synthe sis optimization  and 

compensation for time shifts . 

The resulting data of a synthesis include all the diagrams (UV, radioactivity, 

temperature) recorded, with integration results, time control tables, sequence 

table, a protocol of the entire run and a fract ion table with links to the 

appropriate chromatograms. Thus SynthraView  allows the user to re -establish 

all the relevant information necessary  to reproduce the synthesis  only with the 

data recorded by the system . 

1.1  This Manual õs Audience  

Prerequisites to use this manual are: knowledge  of  how to use the operation 

syste m this software is installed on  and training  on the system this software 

operates to understand the activities of the software and interaction with th e 

synthesis system. K nowledge of HPLC is also very helpful  but not necessary to 

be able to configure the program . There is some information on how to han dle 

some very basic tasks, this way even  a user with little experience  can use the 

software convenientl y. 
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This is not meant to be the user guide for any Synthra synthesis system. All 

the information a user needs to use the system for the predetermined task are 

found  in the Operation M anual , delivered with the synthesis equipment.  Any 

user reading this manua l should be familiar with the Operation Manual of the 

system used.  

Synthra synthesis systems are  completely setup at customerõs site and there is 

no necessity to modify the software , this is only an option.  

A more deep reference to the setup structures will be given in the later 

chapters. They are meant for people who want to optimize their system for 

certain purposes. It  will be explained what to do if the system is modified, how 

to tell the software that so mething on the machine has changed and 

incorporate it into the system visualization.  

1.2  Overview  of the Software Manual  

This manual  is not written for a specific system, it is concentrating on the 

software. This software is used on multiple standard and customized systems. 

Some of the information here may be about features that are not part of a 

system in question.  If there are featur es described in this manual that are not 

part of the system in question , it is not because they are missing but they are 

no element of this  configuration.  

Most figures in this manual are examples of how something is looking like. The 

real appearance is dep ending on the configuration of the system and the 

software version.  
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2  Starting the software  

The software can be started by clicking the SynthraView  Icon on the desktop 

or in the start menu.   

 

Figure 1 (SynthraView ) Icon  

After an automated calibration a welcome window  opens up . 

To go on starting the software the welcome window has to be clicked on or 

enter has to be pressed to continue . 

 

Figure 2 (Welcome Window ) 



SynthraView  Software Manual  Synthra  GmbH 

4  Rev.: 0.1  

3  The main window  

The main window consists of:  

¶ Title B ar 

¶ Menu Bar  

¶ Toolbar  

¶ Display Bar 

 

Figure 3 (Main Window)  

3.1  Title B ar  

The Title Bar  shows the SynthraView  icon and the name of the program on the 

left . In o ther windows  the Title Bar doesnõt always displays the programs 

name; usually  it is the name of the window that is displayed.  This way it is 

easy to distinguish between different windows . On the right there are the 

usual buttons  of most windows to:  

 

Figure 4 (Title bar)  

 

Minimize  the window  

 

Maximize  the window (if it isnõt) 

 

Restore Down  the window (if it is maximized)  

 

Close the window, that will end the program  

One has also the possibility to move the window. Grabbing the Title Bar is 

done by a mouse click onto the T itle Bar (not on the three buttons on the left 

but anywhere else) holding the left mouse button and moving the mouse also 

moves the window. If the wi ndow has reached the destination desired the 

mouse button has to be release to drop it there.  

Most windows  can also be change s in  size. The mouse cursor has to be moved 

onto  the edge of the window to a position where the mouse cursor changes to 

an arrow po inting into opposite  directions. Now it is possible to move the 

edge of the window by clicking the left mouse button and holding it down. 

Moving the mouse into the directions the arrows point change the position of 

the edge. To release the grip on the fram e the mouse button has to be 

released.  To change the window size in two directions at the same time, a 

window corner can be dragged similar to the edges.  
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3.2  Menu Bar  

The M enu Bar is the access area to  all  possible actions one can perform with 

this software . 

 

Figure 5 (Menu Bar)  

Many of the menu items can also be accessed by the Toolbar  (see chapter: 3.3  

Toolbar ). For the common actions available in the Menu - and the Toolbar there 

is an explanation in both chapters to aid the reader who is looking for 

something specific . For Menu Items and Tools that many of the softwareõs 

Menus and Toolbars have in common (e.g.: Open) there will be a special 

chapter called Common Actions  (3.5 ). These are easy to understand actions 

that only need to be explained once.  

We also show all the menus available for a better understanding if the 

program is not available to the reader at the moment.  

3.2.1  File  Menu  

 

Figure 6 (File Menu)  
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3.2.2  Control  Menu  

 

Figure 7 (Control Menu)  

3.2.3  Visualization  Menu  

 

Figure 8 (Visualization Menu)  

3.2.4  Tools  Menu  

 

Figure 9 (Tools Menu)  
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3.2.5  Displays  Menu  

 

Figure 10  (Displays Menu)  

3.2.6  ? (Help Menu)  

 

Figure 11  (Help Menu)  

3.3  Toolbar  

The Toolbar  is a visual way to access the actions , that also can be accessed via 

the Menu Bar . The favorite way o f working, either using the Menu Bar , the 

Toolbar  or a mix is completely left  to the user.  

 

Figure 12  (Toolbar)  

To change the Toolbar õs contents double click in an empty space on the 

Toolbar , the òCustomize Toolbar Windowó will open in that icons can be added 

and removed.  

 

Figure 13  (Customize Toolbar)  

All available icons are shown, those already displayed are checked in the 

checkbox underneath , if the iconôs checkbox is empty it is not shown in the 

toolbar.  

To add an icon the checkbox  under the desired icon has to be checked by a 

single left mouse -click.  

To remove an icon one has to un -check the checkbox under the undesired icon 

by a single left mouse -click on the checkbox to uncheck it that way.  
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3.4  Actions of the Menu - or Toolbar  

 

100% Solvent A Major Pump : starts the pump with 100% eluent A 

and the currently set flow rate  

 

100% Solvent B Major Pump : st arts the pump with 100% eluent B  

and the currently set flow rate  

 

100% Solvent C Major Pump : starts th e pump with 100% eluent C  

and the currently set flow rate  

 

100% Solvent D Major Pump : st arts the pump with 100% eluent D  

and the currently set flow rate  

 

Solvent composition  Major Pump : starts the pumps with the 

solvent composition shown in the òSolvent Compositionó window and 

the currently set flow rate  

 

Flow Rate  Major Pump : opens a window to show the flow rate. A 

change to the flow rate does not start the pumps , but will ta ke 

immediate effect if the pump  is running  

 

Flow rate Flow Controller : opens a window to show the flow rate  

 

Wavelength 1 : opens a window in that the first wave length of a 

serial controlled detector can be entered  

 

Auto zero : will set a serial controlled UV detector back to zero  

 

Temperature : opens a window where  the temperat ure for reactors 

and heaters  can be seen 

 

Voltage : opens a window where  the voltages  for flow regulators and 

pressure regulators  can be set  

 

Load Time Control File or Auto -sample r  Control File : opens a file 

selection window in that a time control file or an auto -sample control 

file can be opened. In the file type box of that window one can see 

that *.tcf (Time Control File) or *.scf (Auto -sampler Control File) can 

be chosen. If the option òStart Pumps after loading Time Control Fileó 

is selected in the time control file, the pumps will begin at once, 

after the file is opened , with the flow rate and solvent composition 

programmed for time 0:00.  

 

Start Time Control File or Auto -sampler Control File : starts the 

time control file or auto -sampler control fi le that has been loaded. If 

the function òHold Time Control File or Auto-sampler Control Fileó 

was executed first, the run will resume by clicking this icon.  
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Hold Time Control File or Auto -sampler Control File : pauses the 

time laps of time of a time con trol file or auto -sampler table. If the 

option òStop Pumps at Time Control Holdó is selected in the time 

control file, the pumps will have a flow rate of 0ml. If hold is active, 

the flow rate of the pumps can be adjusted manually using the òFlow 

rateó icon. 

 

Jump to next Time Control Line : jumps forward in time to the next 

line programmed in the time control table. The first time this 

function is used one must confirm a dialogue box, here it is possible 

to use the option òDonõt ask again.ó to not be asked for confirmation 

anymore.  

 

Stop All : stops the pumps and the time control file. It is not possible 

to resume a synthesis  run when it was stopped.  

 

Manual Sample ID:  enables the user to enter a sample identifier 

starting a time control file. This option is not enabled if processing 

an auto -sampler control file, because the sampler identifiers are 

derived from the accompanying sample identifier file.  

 

Create / Edit T ime Control File:  opens the T ime Control File Editor 

to create or edit a time control file  (see Chapter : 4 Time Control 

Files) 

 

Create / Edit Sequence Control File:  opens the S equence Control 

File Editor to create or edit a sequence control file  (see Chapter : 5 

Sequence Control Files ) 

 

Chromatogram:  opens the Chromatogram Window to show the 

Analysis, Reconstru ct and Reprocess (see Chapter : 6 Chromatogram ) 

 

Peak detection:  opens the window with the automatic peak sampling 

displays.  (see Chapter : 7 Peak Detection ) 

 

System Visualization:  opens the S ystem Visualization Window  (see 

Chapter 8: System Visualization ) 

 

Dispenser Visualization:  opens the D ispenser Visualization Window 

for manual control of the dispen ser  (see Chapter 9 Dispenser 

Visualization ) 

 

Solvent Supply:  opens the window with the S olvent Supply Display  

(see Chapter 10  Solvent Supply ) 

 

Event Box Control : opens the window with the Digital I/O  Control  ( 

see Chapter 11  Event Box Control (Digital IO Control) ) 
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Time Control Visualization:  opens the window with the visualization 

of the time control file and auto -sampler control file in table form.  

(see Chapter 12  Control File Visualization ) 

 

Setup:  opens the S etup Window, in that communication settings, 

device parameter, descriptions etc. - are set  (see Chapter 13  Program 

Settings ) 

 

User Administration: opens the user Administration W indow  (see 

Chapter 14  User Administration ) 

 

Change User: this enables to change the user without closing the 

software (see Chapter 14  User Administration ). 

 

Key -lock:  enables the user to lock the program . After activation, a 

Key-lock Deactivation window appears on the task bar that will 

unlock the program if the user enters the password. The factory set 

password is: SCPA  

 

Serial Communication:  opens a terminal window showing the serial 

communication between the module and the notebook. It is possible 

to òmanuallyó communicate over the serial ports here.  

 

Open Current Working Folder:  opens the folder in that all gathered 

data is saved  

 

Online Help : opens up the program help  

 

About SynthraView : opens the W elcome Window that contains the 

information what version of the software is used.  

 

Exit:  ends the program.  

3.5  Common Actions  

Some of the icons that already appear in the main windowõs Toolbar will also 

appear in the toolbars of other windows.  Because their actions are useful in a 

great variety of context s, those icons are summarized here and the principle 

of what they do is explained.  

 

Open / Load: Opens up a window where a file can be chosen, files 

show depending on the context, only those potentially useful at the 

moment show all others are hidden. If no file should be opened this 

window can be closed by choosing Chancel . 

 

Exit:  Leaves the actual window by closing or if used on the main 

windows toolbar ends the program.  
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Zoom : is used to enlarge parts of the display . To do this a frame has 

to be dragged around the area of interest with the left mouse button 

held down. The area that should be magnified should be included by 

this window. To return to the complete view right -click with the 

mouse.  

 

Save: Writes  changes of a file to the hard drive under a known file 

name. If a new file was created and the file name is not known the  

Save Asé window will open that the user can enter the location and 

name for the new file.  

 

Save Asé saves the file with a new name and/or location (opens the 

Save Asé dialog) 

 

Print : opens a print dialogue to print out the file  

3.6  Display Bar  

The Display Bar is used to visualize all important parameter of the system. 

Some of the systems parameter may already be shown in the System 

Visualization  but most systems have parameter that would be misplaced if 

showing up in that visualization. All of the parameter can be visualized in the 

display bar , no matter if already present in the v isualization or not.  

 

Figure 14  (Display Bar)  

To add or remove displays the Displays  Menu  has to be opened on the Menu 

Bar. The Displays  Menu  is a list of all displays available. Some are checked and 

some are not. Those that are checked can already be seen in the Display Bar, 

those that are not checked cannot be seen in the Display Bar. To add a display 

just click on its name, it will then be added if not present before and removed  

if it was visible before.  

To change the text color of a display , that display has to be right clicked , then 

chose Edit display Color in the context menu  opened , subsequent  a color 

window opens and the color can be chosen by clicking on the desired color 

and finish by clicking the OK button.  

Hint: If there is a display that is showing neither value nor line (a minus like 

symbol that is displayed if there is no value to display) check if the color of the 

display is set to black so that it isnõt readable anymore.  

The arrangement of the displays can also be changed. There is a vertical 

separation line between each neighboring display.  
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Figure 15  

If this line  is clicked on and without releasing the mouse button, pulled 

between two other displays that one that was right to the line can be moved. It 

is pulled along and appearing between the two displays the line was pulled to . 

This is not only working horizontally but also vertically. If a display is pulled 

down  a new display  row appears where the display can be placed.  

3.6.1  Displays of the Display Bar  

The displays look all quite sim ilar so not all are explicitly shown here.  

 

Elapsed Time:  shows the time that has elapsed in a time 

control file. If the time control file is set on òHoldó the display 

will flash between the elapsed time and òHoldó. During the 

injection phase, the display  flashes between the elapsed time 

and òInjectionó. Following the time control file command òWait 

for Inputó the display will flash between the elapsed time and 

òWaitingó 

 

Solvent A: shows the current percentage of eluent A being 

pumped  (also applies to the displays: Solvent B, Solvent C and 

Solvent D)  

 

Pump status : shows the current pump status. ON = pump is 

running,  

¶ OFF = pump has been stopped  

¶ OVER= pump has stopped be cause the pressure was 

too high  

¶ UNDER =pump has stopped be cause t he pressure was 

too low  

 

Flow rate:  shows the pumpõs current flow rate 

 Temperature : shows the heaterõs current temperature  

 

Volume:  indicates the volume pumped since pumping began. 

If the pump is stopped, the volume display returns to 0. 

Depending on the volume pumped, the display unit changes 

automatically from µl trough ml to l  

 Pressure:  indic ates the current pump pressure.  

 Collector Pos.:  shows the current fraction collector position . 
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Fraction Limit:  indicates the fraction limiter status.  

¶ OFF = Limit is inactive  

¶ ON = Limiter is active . 

The LED band displays indicated the volume of the current 

fraction pumped in steps of 1 0%. If the last red LED lig hts  up 

(100%) the limiter triggers a step in the fraction collector.  

(see chapter 13.3  Limiter ) 

 

Valve Control:  shows the current position of the selected 

valve and is also a way of switching the valve manually. To do 

this, select the desired valve and position; click the Set button 

to realize the change.  

 
Vial No. :  indicates the current vial number of the current 

auto  sampler injection  

 

Channel 1 -Channelé: shows the values of the device 

connected to each of the analogue input channels.  The names 

of the channel can vary, in a set up system most o f the used 

channels get renamed so the channel names are more 

meaningful  
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4  Time Control Files  

Time control files are the ideal way to automatize a synthesis. It is something 

like a batch file that tells the synthesis module what to do at what time. The 

line s are not composed via a complicated programming language but by an 

intuitive modular interface.  

The Time Control File Editor can be opened by the icon in the main windowõs 

toolbar or in the Menu Bar via File -> Create / Edit Time Control File.  

The editor shows the time control file tabular as well as graphically. A 

chromatogram can be loaded as a background for the graphic section to check 

the functions of the time control file and adjust them along the time and 

intensity axes.  

The graphic presentation of  functions especially the display of the gradient 

provides improved perspicuity while programming and thus helps to avoid 

mistakes.  

It is a basic principle that every time control file begins at the time of 0:00 

with a set eluent composition and flow rate,  this way the initial conditions of 

the pumps are known.  

Because the time control file stats running after it has been loaded in is 

essential that all valves are set to the normal position and all event box exits 

set . In this way it is ensured that the system is in a defined state.  

If a gradient should be programmed it needs to be taken care that all the 

angles of the gradient as eluent compositions are included in the time control 

file. A linear gradient will be calculated between two different eluent 

compositions at two different times. If a step is to be included into the 

gradient, a start and an end point are added witch  a delay of 0:01. The last 

eluent composition  set will be iso cratic until the time control file is ended 

(manually  or automatic).  

4.1  Edi tor window  

The Time Control File Editor W indow consists of multiple parts:  

¶ Title  Bar 

¶ Menu Bar  

¶ Toolbar  

¶ Time Control Table  

¶ Tab Area 

There is an optional chromatogram area that has:  

¶ Status Bar  

¶ Graphic Time Control File Editor  
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¶ Toolb ar 

 

Figure 16  (Time Control File Editor)  

4.2  Menu Bar  

The menu bar works similar to the most known menu bars. The menus 

available are:  

¶ File 

¶ Edit  

 

Figure 17  (The Time Control File Editor Menu)  

Again most of the entries in  the Menu match icons in the toolbar.  
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4.2.1  File Menu  

 

Figure 18  (File Menu of the Time Control File Editor)  

Load : opens *.tcf  

Save: Saves changes  

Save As é: Saves changes under new filename  

Save As validated :  Saves the time control file as a validated file that cannot 

be changed anymore.  

Print : opens up a dialog to print  

Sim ulation : 

Recent Files Section : the latest files opened are displays in the recent 

files section for easy access.  

Exit : exits the time control editor  

4.2.2  Edit Menu  

 

Figure 19  (Time Control Edit Menu)  

Import Time Control Part : imports the information of the chosen tab on the 

right side from another file.  

Clear all : clears all information of this time control file but the name it 

has. Closing th e editor after this will not save the changes.  
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4.3  Tool Bar  

 

 

Figure 20  (Toolbar of the time control file editor)  

 

Open Time Control File: loads an available time control file  into 

the editor. The types of files you can select to load here are:  

¶ Time control files *.tcf  

¶ Result file *.rfp  

¶ PrepCon4 file *.lgr  

 

Save Time Control File:  saves the time control file  

 

Save Time Control File As:  saves the time contr ol file with a new  

name  

 

Save Time Control File As Validated : saves the time control file as 

a validated file, this file cannot be changed anymore.  

 

Import Time Control Part : is used to import an element of a time 

control file.  The content of the selected tab can e imported from an 

existing time control file.  

 

Clear All : deletes the contents of a time control file. In order to 

prevent data being deleted accidentally a query window opens that 

asks for confirmation on this actio n.  Leaving the program after this 

action wonõt cause the program to save the change or ask for it. 

 

Show Graphic:  Shows the Graphic Time Control File Editor and the 

according Status - and Toolbar  

 

Show Graphic:  Hides the Graphic Time Control File Editor  and the 

according Status - and Toolbar  

 

Print Time Control File : opens a print dialogue  

 

Exit : closes the  time control file editor.  
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4.4  Time Control Table  

 

Figure 21  (Time Control Table)  

The Time Control Table on the upper left shows all steps that a load time 

control file is programed to perform. The information is displayed in a table, 

the first column shows the time code, the second the function and the third 

the parameter for the function. The order is chronologic.  

4.5  Tab Area  

 

Figure 22  (Time Control Editor Tabs)  

The area right to the Time Control Table has various tabs that will be 

explained each in its own here.  

4.5.1  Information  Tab  

 

Figure 23  (Time Control File Information)  

In th e Information T ab of a file  are entered : the author,  the eluents used, the 

column used, a sample identifier and comments. The date is automatically 

added, if the file is saved . The sample identifier is not included if using an 

auto -sampler or if the Manual Sample ID option is activated. The information is 

saved in the results file generated and can be reviewed  later.  
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4.5.2  Checklist  Tab  

 

Figure 24  (Time Cont rol File Checklist)  

The Checklist Tab is used to make the later user of the .tcf check certain 

prerequisites  before a synthesis is started. After starting the control file, the 

checklist is displayed . It  has to be filled and answered before the operation i s 

started.  

User Input:  requires values or names e.g. production No.  

Check Box:  has to be checked  

4.5.3  Options  Tab  

 

Figure 25  (Options Tab of the Time Control File Editor)  

There are different sections in the Options Tab that will be exp lained one by 

one.  

Programming Mode  

In the area Programming Mode of the Options Tab allows to set the dimension 

of the x -axis. The choices are units of time, volume or column volume.  

Volume Calculator  
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To help determining the column volume while programming in those units the 

volume calculator can be used. After entering the length [cm] and the diameter 

[cm] the calculate button has to be clicked and the calculate d volume is put in 

the Column Vol ume fiel d of the Programming Mode area.  

Extended Pump Options  

¶ Start Pumps after loading Time control File : if this option is checked , 

the result is that the pumps start after loading the file with the 

parameter set at t he time 0:00 of the file.  

¶ Stop Pumps at Time Control Hold : determines whether the pump 

should stop if a time control file is on hold.  

Sampling Control  

¶ Disable  Peak Sampling : deactivate s all peak sampling programmed.  

¶ Disable Threshold : disables all thresholds programmed.  

There two options allow disabl ing common functions without deleting ever 

single entry of that kind in the programmed file.  (and saves the time to 

reinsert them)  

Report Printing  

The Automatic Print option determines whether a report should be 

automatically printed after the program run.  

Result -file  

In this area the generation of the result file is configured. A custom filename 

can be set and additionally the following information can be added to the 

filename (if checked):  

Username:  Adds the name of the current user to the filename ( if on ly 

one user is configured in the user setup despite multiple 

operators it makes no sense to use this ) 

Author:  Adds the name of the time control file author to the 

filename  

Time Control File:  Adds  the name of the time control file to the file name of 

the re port  

Sample identifier:  Adds  the sample identifier to the file name  

Vial + Injector:  Adds the number of the current sample vial and the current 

injector to the file name  

Actual Date:  Adds the current date to the filename  

Actual Time:  Adds the current time to the filename  

Auto Increment:  Adds a four digit consecutive number to the end of the file 
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name in order to prevent result files with the same name to 

be overwritten.  

It has to be taken care that no  two  filename s are  same if former results should 

remain available and not overwritten ! 

4.5.4  Activity  Tab  

 

Figure 26  (Activity Tab of the Time Control File Editors)  

The parameters of half -life correction and calibrati on are defined in the 

Activity T ab. The half -life of the radionuclide and t he corresponding dimension 

has to be entered in half -life -time . Either time or area can be chosen as 

Reference  area for baseline correction of half -life -time corrected 

chromatograms selected by Channels.  

The setting of data channels to Start -activity and P roduct -activity allows the 

calculation of recovery with the following equation:  

ὙὩὧέὺὩὶώϷ
ὖὶέὨόὧὸ ὥὧὸὭὺὭὸώ

Ὓὸὥὶὸ ὥὧὸὭὺὭὸώρzππ
 

In the lower area of the A ctivity Tab all parameter for calibration can be 

entered. Above the table the calibration chromatogram and the channel is 

selected.  

The table is used for input of peak name, rete ntion time and peak -window in 

time -percent  and amount value in the standard. With that  information the 

system calculates the response factors that  are used for analyzing peaks with 

similar names in the following chromatograms.  
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4.5.5  Functions  Tab  (Creation of Time Control Files)  

 

Figure 27  (Functions Tab of the Time Control File Editor)  

In the Functions T ab all programmable funct ions for a time control file can be 

found. The editor bar is at the bottom of the tab;  all the program steps are 

entered here together with the time and parameter s. The parameter boxes in 

the Editor Bar change depending on the function selected.  

It has to be taken notice that time is not entered in a sexagesimal  way. The 

time in these programs is counted in decimal numbers.  

(e.g. sexagesimal counting of units smaller than minutes: é0:58; 0:59; 1:00; 

1:01... Counting in this program é0.58; 0.59; 0.60; 0.61; 0.62; é 0.98; 0.99; 

1.00; 1.01; 1.02 é) 

The Insert button adds the current command set to the time control file. The 

order of entering the steps is not of re levance they are sorted by the time code 

they get if  entered.  

The overwrite button exchanges the contents of the line in the table , that is 

selected , with the contents of the Editor Bar.  

The Delete button deletes the line that is selected in the table.  

Most functionõs time can be changed by selecting the already inserted function 

in the table and then right clicking on them. A context menu appears thatõs 

only menu item is Cut / Insert Time. Choosing this menu item by clicking on it 

with the left mouse butto n this will cause a small time selection arrow to pop -

up. Here a time offset can be entered, a negative if the execution should begin 

earlier, positive if later, this changes the execution of the selected and all 

following program steps, it shortens or len gthens the break where the arrow 

has been.  

The functions are explained in the chapter 4.6  Time control file commands  

http://dict.leo.org/ende?lp=ende&p=Ci4HO3kMAA&search=sexagesimal&trestr=0x8004
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4.5.6  Threshold  Tab  

 

Figure 28  (Threshold Tab of the Time Control File Editor)  

The Threshold tab allows programming of threshold events , this way a set of 

device control functions can be executed if an observed parameter  exceeds , or 

drops below a certain value. The threshold allows individual fractioning and 

system monitoring possibilities by the aid of selectable data source, 

programmable time frames for activities and programmable threshold levels. 

Up to 50 threshold observation s can be active at any time.  

The graph on the left of the tab is used to select the threshold parameter. 

Click anywhere on the graph (except on to the red dots LEDs ) and the general 

threshold parameters show up on the right side of the tab.  

In the upper s election box the input channel can be chosen , this determines 

the channel to observe . Available are the analogue channels, the sys tem 

pressure and  the event box inputs. The boxes Start Time [min]  and End Time 

[min]  are used to set the time frame for the ac tivity of the threshold. In the 

value box the parameterõs thresholds value is entered. If  using an event box or 

game port input, this parameter is not available, since the data source only 

has two possible states (Low = Threshold Under Even; High = Thresho ld Over 

Event) 

Area delay describes a delay time for the threshold event that is depending on 

the integrated area the observed parameters function creates.  

Clicking on the left LED (red dot) , on the graph , opens the òOver Event 

Functionsó table. Here the functions that should be carried out , if a threshold 

over event happens , can be entered. The desired function can be selected in 

the boxes Device and Operation beneath the table. Clicking on the Insert  

button inserts the set device operation into the time c ontrol file. If Overwrite  is 

clicked the selected (red) line is replaced by the settings of device operation 

set. If Delete  is clicked the selected line is removed.  

Similar to this a òThreshold Under Eventó is configured by clicking on the right 

LED of the  graph.  
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4.5.7  Peak Sampling  Tab  

 

Figure 29  (Peak Sampling Tab of the Time Control File Editor)  

The Sampling T ab allows the programming  of peak sampling. Peak sampling 

makes it possible to carry out a set of device control functions triggered by an 

automatically recognized peak situation. Peak sampling takes place in so 

called peak windows, whose start and end time can be set by the user. The 

data source, sensit ivity of peak recognition and functions to be carried out are 

set for each peak window individually . This empowers to react to single peaks 

separately on an individual basis. If fractioning in combination with threshold 

values, the thresholds and peak samp les always combine to form one fraction 

event. This means that as long as the thresho ld is still exceeded or the peak  

sampling has not yet recognized the end of a peak, fractioning continues.  

The graph of peak situations is used to select the peak sampling  parameters 

and peak situations. Click anywhere on the graph except on the red or blue 

dots (LED), the peak -window setup will appear to the right of the graph. The 

following parameters can be entered here:  

Name:  Peak Windows get individual names to be able  

to differentiate them.  

Time:  Start and end time of the peak window.   

Data Source:  The source of data can be selected here  

Filter Factor:  indicates the number of data points used for 

the first derivation if calculating the gradient  

Slope Sensitivity:  indic ates the size of the gradient above which 

the start of the peak is recognized.  

Max. Baseline Level:  is used as a threshold value for peak sampling. 

No peak end is recognized above the value 

entered.  

Max. Fractions:  is only relevant to the Defined by Peak W indow 

setting that is a possible position setting for 
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motorized switching valves. I t  indicate s the 

maximum number of fractions that can arise in 

this peak window.  

Excessive Fractions to:  option determines where the fractions that 

exceed the maximum number of fractions 

should be pumped.  The ôCurrent õ setting 

pumps them in the current position; the 

ôWasteõ setting pumps them into the waste.  

End Sampling at Window End:  indicates whether fractioning should continue 

after the end of the time period of a peak 

win dow or whether the system should switch to 

waste.  

To program peak sampling events , click on the LED at the desired location. A 

function table will appear on the tight side that  can be filled with functions.  

The possible peak sampling situations are:  

Peak window start:   the blue LED on the left, is  the time the peak window 

òopensó; starts observing the parameter 

Peak window end:  the blue LED on the right side, is the time the peak 

window òclosesó; stops observing the parameter 

Red LEDs from left to right:  

Peak Start:  start of a peak as recognized by the peak sampling  

Peak Valley:  dip in a peak recognized by the peak sampling  

Peak Shoulder:  shoulder of a peak recognized by the peak sampling  

Peak End:  end of a peak recognized by the peak sampling  

The desired event  can be selected in the boxes Device and Operation  beneath 

the table. Clicking on the Insert  button inserts the set device operation into 

the time control file. If Overwrite  is clicked , the selected (red) line is replaced 

by the settings of device ope ration set. If Delete  is clicked the selected line is 

removed.  

The following rules apply to the sensitivity of peak sampling:  

¶ The smaller the data point density, the faster and more sensitive the 

peak sampling. (However it has to be mentioned that very sma ll slice 

widths lead to large results files)  

¶ The smaller the Filter Factor, the faster and more sensitive the peak 

sampling. (The range of this factor is 5 to 15 and the value entered has 

to be odd)  

¶ The smaller the Slope Sensitivity, the more sensitive is the peak 
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sampling.  

4.6  Time control file commands  

Composition Major Pump : determines the eluent c omposition for the primary 

pump  of the system . Entries are made in percent 

and switching  into the following box the entry will 

automatically have the missing diffe rence to 100% 

entered.  (e.g. if entering 80% for eluent A leaving 

this field automatically fills in 20% into the field of 

eluent B)  

Flow rate Major Pump : determines the flow rate of the primary. Changes 

are made in discrete steps; a flow rate gradient for 

example cannot be entered. Values are entered in  

ml/min.  

Start Chromatogram : starts plotting the chromatogram for the analogue 

channels selected, with the data point density 

entered in Slice Width . 

Stop Chromatogram : stops p lotting the chromatogram for the analogue 

channels selected or if all active is selected, stops 

plotting the chromatogram for all the analogue 

channels.  

Acoustic Signal : initiates a sound reproduction of the *.wav file 

selected with an interval of 4 second s. The test 

button plays the file. The sound will end if the time 

control file is stopped.  

Analog Output:  is used to control external instrumentation 

according to the specifications.   

Restart Time Control File : is used to restart the time control file. It is 

possible to select the parameter ôLoopõ for an 

endless loop or Repeats in order to enter a certain 

number of repeats , once  all the iterations have 

been performed this command will be ignored for 

this program run.  

Digital  Output : is used to switch one of the 12 digital  outputs. The 

required digital  output and the state to be 

switched to [On, Off, Pulse ] has to be selected as 

parameters.  

Wait for Input  Signal : puts the actual time control file on hold until the 

selected event box in put or the game  port has the 

state programmed [ On, Off, Pulse ]. (This function 

can be used e.g.  if injecting with a manual 
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injection valve. ) 

Load new File :  is used to load and start the time control file 

selected. This allows linking several time control 

file.  

Dispenser : controls the installed dispenser of  the system. For 

each selected dispenser (1 -4) one of f our 

operations can be selected:  

¶ Aspirate  to fill the syringe  

¶ Dispense  to discharge  

¶ Dose for the delivery of solvents (aspirates 

and dispenses)  

¶ Initialize  to initialize the dispenser  

The speed of the syringe is entered in µl/min  filled 

syringe. In Source and Destination the port s of the 

dispenser valve have to be set.  

Temperature : sets a temperature for a heater; the parameter is 

temperature in °C . 

Stop all : is used to end the run and stop the pumps.  

Virtual Switch : is a program variable that can be set and read.  

Display Information : is used to manually  add text annotations to the 

chromatograms . 

Valve Position : is used to switch valves. Select the Valve and the 

final position as parameter. To set all valves into 

the same position select All Valves . 

UV-Auto -zero :  automatically returns the UV detector to zero.  
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Collector:  programs a fraction collector position. The 

parameter can be:  

¶ Home ð to return t o home position  

¶ Step ð to move to the next position  

¶ Position ð to move to a certain position  

4.7  Graphic Time Control File Editor  

 

Figure 30  (Graphic Time Control File Editor)  

The Graphic Time Control File Editor is used to create a graphic representation 

of a time control file and allows visual editing. All the functions of the time 

control file are sown as colored lines that can be moved horizontally 

(movement in time) and vertically (changing the threshold value or peak limit) 

with  the mouse. A selected function in the table of the time control file will 

flash the graph belonging to that function. Peak windows are also represented 

graphically and can be created and edited with the mouse.  

A programmed gradient development is also rep resented by colored lines the 

y-axis minimum is 0% and the y -axis maximum is 100%.  

A chromatogram can be opened as background; it can be used to adjust the 

functions of the time control file. The display colors of all the functions can be 

selected in the Graphic Time Control File Editor color setup , and any functions 

that should not be visible can be deactivated.  

4.8  Status Bar  

The Status Bar in the Graphic Time Control File Editor shows the name of the 

time control file open, the name of the chromatogram open and an 

information box indicating:  

¶ The time control function that the mouse curser is hovering over or that 

is moved by the aid of Single Function Moving.  

¶ The time by that the function is shifted using the Multi -Function Moving  

¶ The name and times of the pe ak window that the mouse curser is 

hovering over using the Create / Edit Peak Window function.  
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4.9  Graphic Time Control File Editor Tool Bar  

 

Load Chromatogram : opens a dialog to choose a chromatogram 

that is  used as background   

 

Clear Chromatogram : removes  the chromatogram  in the 

background  

 

Single Function Moving : allows to move single functions  

 

Multi -Function Moving: allows moving multiple functions. To do this 

begins  by drawing a time window with the left mouse button held 

down. All the functions wi thin the window are then moved with the 

mouse at the same time. Holding down the right mouse button will 

adopt the time shift.  

 

Create / Edit Peak Window: allows editing and creating peak 

windows. To create a peak window, hold down the left mouse button 

and draw a new window on the screen.  Releasing the mouse button 

triggers a query window for the name of the new peak window.  

An existing peak window can be edited by moving the mouse over it, 

the cursor will change depending on its position on the window, an 

arrow pointing left on the left hand side of the window to an arrow 

pointing right and left in the center of the window to an arrow 

pointing right at the right hand side of the window. By holding down 

the left mouse button the peak window can be moved o r extended 

depending on the position the mouse cursor was while pressing the 

mouse button. Right clicking on a peak window opens a context 

menu where the window can be renamed or deleted.  

 

Zoom Graphic: is used to enlarge parts of the graph.  

 

Print Graphic prints the graph  

 

Color Setup opens the time control file editorõs color setup. In this 

window the colors of the background , peak windows and functions 

can be changed, activated or deactivated.  
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5  Sequence Control Files  

The editor shows the Sequence Control File as a table. A sequence control file 

is in principle a series of time control files.  

The sequence control file editor can be opened by the icon in the main 

windowõs toolbar or in the menu bar via File -> Create / Edit Sequence File.  

 

Figure 31 (Sequence Editor)  

The runtime programmed into the sequence control table determines the time 

the actual time control file ends and the next begins.  

 

5.1  Sequence Editor Toolbar  

 

Load Sequence Control file: opens a Load time  control Sequence 

window to choose the  file to be opened.   

 

Save Sequence Control File: Writes  changes to a sequence control 

file to the hard drive  

 

 

Save Sequence Control File Asé: saves sequence control file 

under new name.  

 

Add Time Control File : opens the add control file window. Here 

the time control file to be added can be chosen  

 

Delete Selected Time Control File : w ill delete the selected time 

control file from the sequence run list.  

 

5.2  Creat ing S equence Control files  

 

Figure 32  (Sequence Control File)  

For creating a sequence control file the Time Control Files that should be 
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chained must already exist. Pressing the Add Time Control File button opens a 

dialog to choose a Time control file that is after pressing OK in that dialog 

added to the sequence. The order of the files is the order that they are added, 

a new added file is put at the end of the sequence.  

If the order of files should be changed every row can be dragged into a new 

position. The mouse c ursor has to be placed on the item to replace. Then he 

left mouse button has to be presses down. Without releasing the mouse 

button the item has to be moved to the new location in the table. Releasing 

the mouse button places the item.  

The editor evaluates the last step of the file and sets it as runtime for this 

sequence step. The run time can be changed manually. If the run time is 

shorter than the real time needed for a time control file to process the file will 

be stopped and the next one starts. If the run time is longer than the time to 

process the time control file, the additional time is waiting rime.  
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6  Chromatogram  

The Chromatogram window can be opened by the icon in the main windowõs 

toolbar or in the menu bar via Visualization -> Chromatogram.  

The Ch romatogram window has three modes available, selectable by the first 

three leftmost toolbar icons.  

 

Figure 33  (Tool bar of chromatogram window)  

 

Analysis Window : records and visualizes analog signals  

 

Reconstruction Window : opens and visualizes saved synthesis run 

data  

 

Integration Window : is used to reintegrate chromatograms  

 

6.1  Data Recording (Analysis  Window)  

The Chromatogram W indow can be opened by the icon in the m ain windowõs 

toolbar or in the M enu Bar via Visualization  -> Chromatogram.  

PIC 

This window is also called the data -recording window, it is used to display and 

record analogue signals (like UV, radioactivity or temperature).  

Data recording is started in the time control file with the command Start 

Chromatogram an d stopped by the command Stop Chromatogram. 

Chromatograms can start simultaneously or with delay.  

While a time control file is running, the graphic display of the time control file, 

the current chromatogram trace, the programmed peak windows, the gradient 

and the current chromatogram labels are displayed in the data recor ding 

windows. Just like in the G raphic Time Control File Editor there is the 

possibility to edit control file functions and peak windows in the data 

recording window. These changes take eff ect in  the current run and can also 

be saved in the time control file opened. This way it is possible to intervene  in 

a running process. However if a gradient  is moved , this will not take effect 

until the next time the time control file starts.  

After prefo rming a change in the File of a currently running program there will 

always be a query if the changes should be saved to the file.  
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6.1.1  Toolbar  

 

Channelé: is used to open or close a data channel window. Only the 

buttons for the channels that can be selected are  sown. The U button 

belongs to a user defined channel . Data channels which are 

programmed into a time control file are automatically opened upon 

loading. If no data recording is active, the data track selected runs in 

base line mode, i.e. from the left to the right edge in about 8 

minutes as an endless loop.  

 
Spectrum Channel : is used  to show the hidden spectrum channel of 

the DAD . 

 

Show Functions: is used to show or hide the time control file 

functions. If the functions are hidden the contents of the window is 

scaled to fit the area of the data recording.  

 Show Peak Windows : is used to show or hide the peak windows.  

 Show Gradient : is used to show or hide the programmed gradients.  

 Show Annotations : Is used to show or hide the current annotations.  

 
Show Last Chromatogram: automatically loads the last 

chromatogram as background image in the data channel window  

 
Show Elapsed Time Line:  is used to show or hide the vertical line 

indicating the elapsed time.  

 
Single Function Moving: enables to move a s ingle function. Changes 

take immed iate effect in the current run.  

 
Multi -Function  Moving: enables to move multiple functions ref. 

Changes take immediate effect in the current run . 

 

Create / Edit Peak Window: allows creating and editing  peak 

windows (see chapter 4.5.7  Peak Sampling  Tab). Changes take 

immed iate effect in the cu rrent run.  

 
Load last Chromatogram:  is used to load the last chromatogram 

manually, as a background image for the data channel window.  

 

Channel Setup: opens the window with the settings for the 

individual data channels. The different parameters are  described in 

chapter 6.1.3  Data channel settings . 

 
Automatic Print: activates or de activates  the automatic printing of 

the report after the recent run.  

6.1.2  Status Bar  

The Status Bar of the chromatogram window  has three information areas.  



SynthraView  Software Manual  Synthra  GmbH 

34   Rev.: 0.1  

The leftmost one is a visualization of the actual status:  

 
Baseline: baseline is displayed  

 
Ready:  data channel is in use, but has not yet started.  

 
Chromatogram running: data recording is active.  

 
Chromatogram finished: data recording has finished.  

The box to its right shows the chromatogram running time and the rightmost 

box shows the current status with the name of the result file.  

PIC 

6.1.3  Data channel settings  

The window always shows the data of the selected channel, i.e. the analysis 

window in focus. In the Name box t he name of the channel can be changed . 

The data source of the channel is determined by the checkbox A/D Converter 

or DAD for data of the A/D conversion cards and DAD for the data of the DAD. 

The DADõs range of wavelength is set in the boxes adjacent to the DAD. The 

Offset parameter can be entered to compensate for a detector offset. The 

Value entered will be added to the analogue signal (it can be positive or 

negative). The Factor Parameter is used to correct the size of the analogue 

signal. A factor o f 1 shows the analogue signal at its original size. The Y -

Maximum and Y -Minimum parameter determine the scale of the y -axis. The 

Auto Scaling option automatically corrects the scaling if these values exceed 

or the corresponding minimum or maximum signal. T he measurement unit if 

each channel can be set in the Dimension box. Clicking the Color 1 or Color 2 

box opens up a color selection dialogue that can be used to set the color of 

each chromatogram trace. Color 1 is the color of the current chromatogram; 

Color 2 is the color of the last chromatogram that is displayed if the Show last 

Chromatogram function is used. The Apply button applies the settings, and 

the OK button applies the settings and closes the window.  

Choose the type of the display spectrum in the  setup window for the DAD 

spectrum in the area Spectrum Type.  

Dark Current is the remaining current without exposing the diode array.  

Reference Spectrum is a saved lamp spectrum. A reference spectrum can be 

set manually by the Set Spectrum function key . Otherwi se it is set 

automatically at the time SynthraView  starts.  

Absorption Spectrum of DAD is the logarithm of the reference spectrum minus 

the logarithm of the actually measured lamp spectrum.  

The refreshing pa rameter defines after what time the spectrum display is 

actualized. Y -Maximum and Y -Minimum values define the scaling of the y -axis. 

The Auto Scaling option automatically fits the scaling according to the signalõs 
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maximum and minimum.  

6.2  Reconstruction  

Result  files can be opened and displayed in the reconstruction window. 

Chromatograms, time control file functions, peak windows, gradients, 

chromatogram labels and the protocol of the synthesis run can be displayed. 

The chromatograms can be displayed individuall y or in the case of multiple 

channel data recording, superimposed. To enhance the visibility of certain 

areas it is possible to drag a zoom window. To perform a zoom place the 

mouse curser inside the chromatogram area. Hold down the left mouse 

button. Drag ging now letõs appears a rectangle that one corner sticks on the 

point where the left mouse button was pushed down and the other corner is 

still connected to the mouse cursor. Capture the area of interest in this frame. 

Releasing the left mouse button will  cause an automatic zoom in the area 

chosen. To return to the total view the right mouse button has to be clicked 

onto the chart.  

6.2.1  Toolba r of the R econstruction Window  

 

Open Result File : opens the Open Results File window  

 

Previous Results File : loads the result file that is located directly 

before the already open file if ordered by name . 

 

Next Results File: loads the result file that is located directly 

behind the already open file if ordered by name . 

 

View Sample Information : opens a window é 

 

View Protocol : opens a window that displays the run protocol 

ordered by time.  

 

View Peak results : opens a table that shows the results of the 

integrations.  

 

View Peak Value : is used to register the peak values. After 

selecting this function, a crosshair will appear on the graph that can 

be moved along the chromatogram trace. The time and intensity 

will be displayed on the cross hair lines. In a multiple channel result 

file, only one chromatogram can be selected to register peak 

values.  

 

Export  Chromatogram: is used to export one or more 

chromatograms. The export formats can be selected in the file 

section window as file types. Possible export formats are .CSV if to 

import the data in a spreadsheet application  or a slice file to import 

the date into ChromStar.  



SynthraView  Software Manual  Synthra  GmbH 

36   Rev.: 0.1  

 

Print Results File:  is used to print the result file loaded. After 

selecting this function a the Report Options window open, here 

different options can be chosen:  

Chromatogram prints the chromatogram as it is on the screen  

Peak Results prints the table of peak results  

Fraction Table prints the result fileõs fraction table 

Run Protocol prints the protocol of the run  

é 

 

Show Channel: shows or hides each chromatogram . Hidden 

chromatograms are not displayed on screen, and do not appear on  

a printout either.  

 

Show Function: shows or hides the time control files functions. If 

the functions are hidden the window contents is scaled to fit the 

contents of recorded data.  

 

Show Peak Window: shows or hides Peak Windows.  

 

Show Gradient: shows  or hides Gradient.  

 

Show Annotations: shows or hides Annotations.  

6.2.2  Status B ar  

The status Bar at the bottom of the window shows the complete path and 

name of the result file opened. Moving the  mouse curser on a function the 

time and parameter values of t his function will be displayed in the status bar.  

6.3  Reintegrating Chromatograms  

The third option of the Chromatogram window is the reintegration. It is 

possible to reintegrate the chromatograms of result files in the integration 

window.  

The chromatograms can  be reintegrated individually or in groups in case of 

multiple channel data recording. Once reintegration has been performed it is 

saved automatically. The original integration remains in the result file, this way 

it is always possible to return to the ori ginal data.  

Reintegration allows optimizing the integration of your chromatograms at a 

later time.  If the time control file  is loaded  from a reintegrated results file into 

the time control file editor, the program will recognize the reintegration and 

ask i f reintegration parameter should be load. This time control file is identical 

to the one that  completed the last run but contains the integration parameter 
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of the reintegration.  

To magnify certain areas of the chromatogram on the display it is possible to 

drag a zoom box.  To perform a zoom place the mouse curser inside the 

chromatogram area. Hold down the left mouse button. Dragging now letõs 

appears a rectangle that one corner sticks on the point where the left mouse 

button was pushed down and the other co rner is still connected to the mouse 

cursor. Capture the area of interest in this frame. Releasing the left mouse 

button will cause an automatic zoom in the area chosen. To return to the total 

view the right mouse button has to be clicked onto the chart.  

 

6.3.1  Toolbar of the reintegrating window  

 
Open Result File : opens the Open Results File window where the file 

to reconstruct can be chosen  

 
Channelé: is used to select the chromatogram shown in the 

reintegration window . 

 
View Peak Results: opens the window with the display of the 

integration results in table form . 

 
Integration Tools : opens a window with the function buttons and 

parameter boxes for reintegration.  

The Integration Tools window contains the tools necessary for reintegration. 

As described in ch apter the integration parameters are saved with the peak 

windows. Performing reintegration always concerns the part of the 

chromatogram with the selected peak window. The parameters of the first 

peak window apply from the beginning of the chromatogram.  

 

Figure 34  (Integration Tools)  
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Until the time the next window begins, these parameters remain standard for 

integration. The buttons in the toolbar provide the following functions.  

 

Previous Peak Window : is used to select the previous peak window. 

The peak window selected is framed in the graph in the reintegration 

window. The name of the window is displayed in the box below the 

toolbar.  

 

Next Peak Window : is used to select the next peak window. (see 

previous window)  

 

Edit / Create Peak Window: enables you to c reate and edit peak 

windows (see chapter 4.5.7  Peak Sampling  Tab) 

 

Integrate Selected Channel : reintegrates the selected 

chromatogram.  

 

Integrate All Channels : reintegrates the selected channels the 

chromatograms of the results file loaded.  

 

Original integration : reverts to the o riginal integration.  

The reintegration parameters have the following meaning:  

Maximum Baseline Level  ð functions as a threshold for peak sampling. No 

more peak ends are recognized above the value entered [mV]  

Filter Factor  ð Shows the number of sl ices used to form the first derivate of 

the gradient calculation.  

Slope sensitivity  ð indicates the size of the gradient where a peak beginning 

is recognized [µV/s]  

6.3.2  Status Bar of the Reintegration  Window  

The Status Bar at the bottom of the window shows the path  and name of the 

results file opened . 
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7  Peak Detection  

The Peak Detection Window shows the actual status of peak detection.  The 

Peak Detection Window can be opened by the icon in the main windowõs 

toolbar or in the Menu Bar via Visualization -> Peak Detection.  

 

Figure 35  (Peak Detection Window)  

The peak detection window visualizes the status of peak detection during any 

synthesis run. It shows the name of the peak window as well as all other 

information of the peak. (Fo r further information on peak sampling see 

chapter 4.5.7  Peak Sampling  Tab)  

 

Disable Peak Sampling:  disables all peak sampling  
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8  System Visualization  

The System Visualization window can be opened by the icon in the m ain 

windowõs toolbar or in the Menu Bar via Visualization -> System.  

The System Visualization is used to display the process flow graphically, as 

well as operation  interface all the devices that can be controlled  manually  by 

means of the visualization. The visualizations can also show data relating to 

the detector signals, auto -sampler  vial numbers, fraction collector position and 

temperature.  

A library of graphic objects and the use of background images in BMP format, 

allows creating individually configured system visualizations.  

Each of the active devices that can be visualized displa ys the current position 

or state all the time. The visualization window can be scaled using the Zoom 

menu or dragging the borders of the window.  

8.1  Functions  

All the active devices visualized can be controlled can be controlled online 

some with  the aid of con text menus.  

Two state devices can be switch by double clicking on their representation in 

the visualization.  

The menu is opened by clicking the right mouse button onto a device that 

should be controlled. The first Level of the menu always contains the elem ents 

name that was chosen, hovering the mouse cursor over the area with the name 

opens the options menu. There the possible options can be; the option that is 

active at the moment is checked. By left clicking a different option the device 

is switched.  

A ri ght click on a box (value label) shows its data source.  

8.2  System Visualization Setup  

The System Visualization Setup W indow can be opened via  the menu File -> 

Setup in the S ystem Visualization Window.  

8.2.1  Toolbar of System Visualization Setup  

 Load Visualization : opens a pre viously created visualization.  

 Save Visualization : saves the visualization to the hard drive.  

 

Load Background Picture: opens the Load Background Window 

where a background file , in BMP format for the visualization , can be 

chosen. All the background images are located in the Visualization 

Backgrounds subfolder of the visualization folder of the SynthraView  

installation folder.  
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Clear Visualization : deletes all loaded visualization elements. To 

avoid accidental deletion pressing this button opens a confirmation 

dialog  that asks the user if the visualization should really be cleared.  

 Rotate Object 90°: rotates the object selected 90° clockwise.  

 Flip Object : flips the object selected horizontally.  

 

Insert Object: adds the object selected to the visualization window. 

All objects are inserted in their basic position and need to be moved 

to the correct destination and placed.  

 
Place Object: fixes t he inserted object at the current location in the 

virtualization.  

 Exit Setup: closes the Visualization Setup Window.  

8.2.2  Creating  / Modifying  a Visualization  

To create a new visualization the first step is to draw a background image that 

corresponds to the deviceõs tubing system. This image has to be of the file 

type .BMP. A program of choice can be used for that, in the subfolder Bitmap 

Library of the Visualiz ation folder of the SynthraView  installation folder a 

number of models for the elements  can be found . The finished background 

itself has to be saved to the subfolder Visualization Backgrounds of the 

Visualizatio n folder of the SynthraView  installation folder.  

The background picture has to be opened in the Visualization Setup with the 

Load Background Picture function. Now the active visual elements have to be 

placed on top of that background picture. On the left si de of the S etup Window 

there is a table containing all possible graphical representations for the active  

and passive  elements. The chosen element is displayed in the center of the 

Visualization Setup window. On  the right side of the Visualization Setup 

window there is a table of all devices of the system that can be visualized. If 

choosing the object Value Label the table to the right changes and only show s 

devices whose values can be visualized.  

In the devices section of the setup window the state of every device is also 

mentioned. There are two different states  concerning the visualization setup : 

¶ Free:  The device is not in the visualization yet.  

¶ Selected:  the device is already part of the visualization, adding it a 

second time will open a window asking if it is intended to create a 

multiple visualization object. Answering with yes creates a copy that 

shows the same state as all its clones (the maximum number of clones 

is 5).  

As already mentioned the graphic chos en is shown in the central preview 

window, it should be taken care to give the object the right orientation, 

corresponding to the element of the background image. Elements can be 
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oriented by using the Rotate Object 90° and the Flip Object functions. 

Subsequent to this, the object is transferred into the visualization area by 

using the Insert Object function. The object will appear in the top left corner 

of the visualization. It can be dragged into the right position by placing the 

mouse cursor over it, hold ing the left mouse button and moving it into the 

desired position. The object can also be positioned by using the arrow keys on 

the keyboard. If the object is in position the Place Object function has to be 

used to fix it there.  

8.3  Visualization and time cont rol files.  

The system visualization and the programming of time control files is liked in 

a way that simplifies programming .tcf files.  

If selecting a line of a time control file with a valve operation, the valve 

incorporated in this operation gets a pulsing red frame that highlights the 

valve that is affected by the selected line of the time control file.  
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9  Dispenser Visualization  

The Dispenser Visualization Window can be opened by the icon in the main 

windowõs toolbar or in the Menu Bar via Visualization ->Dispenser.  

 

Figure 36  (Dispenser Visualization)  

Depending on how many dispenser the system has there will be one tab for 

each. On the left side a scheme of the dispenser is shown.  (Please note that 

the dispenser will not show  upside down even if it is installed that way in your 

system)   

Dispenser Ready:  

Syringe Delay:  

Instruction pipeline:  shows all commands for the dispenser that are given but 

not executed yet  like a command cue.  

Command:  shows the actual command that is send  to the dispenser  

Response : shows the response of the dispenser, the dispenser 

response can tell if a command could be executed 

successfully or not.  

Manual control:   This area allows manual control over the dispenser  

Source Valve:  sets the valve number tha t will be the source  

Speed:  sets the speed that the dispenser will use to fill itself  

[µl/min]  

Destination Valve:  sets the valve number that will be the drain  
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Speed:  sets the speed that the dispenser will use to drain  itself  

[µl/min]  

Volume:  Sets the volume that is either taken from the source or 

pumped to the train, or both depending on the operation 

performing  

Delay:  is the time delay between aspiration and dispense if a 

dose is performed  

Initialize:  pushing this button the dispenser will check its o wn 

positioning by going from one positive stop to the other 

and checking the valves  

Aspirate:  the dispenser fills itself with the parameter set in Source 

Valve at  the according speed  

Dispense:  the dispenser discharges itself with the parameter set in 

Desti nation Valve at  the according speed  

Dose:  will cause the dispenser to charge and discharge itself 

and so pump the amount set in Volume  from source to 

destination with a certain Delay if applicable.  

Stop:  ends all dispenser actions at once and clears the 

in struction pipeline.  
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10  Solvent Supply  

The Solvent Supply can be opened by  the icon in the main windowõs Toolbar or 

in the Menu Bar via Visualization -> Solvent Supply.  

The solvent supply display is used to control the supply of solvents. To save 

the  column fr om running dry one has the possibility of setting two volume 

limits in [percent ]. If the volume drops below the first limit an acoustic 

warining  will sound and dropping below the second limit the pumps will be 

stopped.  

The values displays are based on the calculated used volume of solvent at the 

current flow rate and time passed. This means that there is no provision for 

pump tolerance in this calculation. For this reason the volume limits for the 

warning and pump shut down should allow a certain leeway. Re gular control of 

the supply containers also helps to prevent that the column runs dry.  

10.1  Solvent Visualization  

The supply of solvents A to D and the level of the waste container are s hown 

as a graphic on the left and side of the window. They are intended to allow the 

user to make instant checks.  

A solvent that has dropped below the minimum percent level set or a waste 

volume that has exceeded the maximum percentage level will be marked with 

a red exclamation mark. The right side of the window can be expanded with 

the More Info button. It can be collapsed again with the Less Info button. The 

right side of the window displays the solvent names and the numerical solvent 

quantities. It also shows the solvent consumption for the current run. The 

values are shown as  absolute volumes and as percentage of the total volume.  

On the right side the solvent names are displayed, with the current values as 

volumes and percentages next to them.  

The values next to Actual Run Uses show the solvent consumption of the time 

control  file loaded as a volume and percentage. Tis display is intended as a 

check of whether the solvent supplies are sufficient for the current run.  

10.2  Solvent Supply display settings  

In the Volume Settings T ab, names for the solvents A to D can be entered in 

the name section. The total volume of the individual solvent container has to 

be noted in the boxes below Total[l] and the actual volume in the fields below 

Current[l]. The pumps should be stopped if the current solvent volume is 

entered since the fields where  they ought to be entered are updating all the 

time if the pumps are running and every try to enter a value is immediately 

overwritten. With the [l] button in the bottom right the units can be switched 

between [l] and [ml]. The Refill All button returns al l solvent containers to 

100% and the Waste to 0%. The Save button applies and saves changes. The 

option Acoustic warning até.: sets the threshold at that the alarm will sound. 
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The second threshold has the option òStop alló or òHold with Pump stopó is 

used to stop the pumps in order to prevent the column from running dry.  

Stop all : stops the time control file and the pumps (a stopped 

time control file cannot be resumed)  

 Hold with Pumps stop:  pauses the time control file and sets the pumps to 

a flow rate of 0ml. After the solvent containers have 

been refilled it is possible to resume the time control 

file with Continue.  
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11  Event Box Control (Digital IO Control)  

The Digital IO Event Box shows the 12 outputs that are used to control system 

components and 12 inputs that are used to capture system signals.  

The outputs are depending on channel mapping.  

The inputs are low active, i.e. they are considered to be active if they are 

connected to ground, or if the input voltage is around 0V. In this example only 

digital input No 5 is used, for the digital input of the fluid detector. Examples 

of other applications for the inputs are:  

¶ Feedback from an injection valve  

¶ Control ling devices with TTL input  

¶ Etc. etc.  

 

Figure 37  (Digital IO Control)  

The first four outputs are solid state relays that can switch pumps for example 

at 24V up to 6A. The seventh and eighth switches control the magnetic 

stirrers. Output nine controls the high voltage used for the Geiger Müller 

counters.  

The Digital inputs are visualized by the LED representations in the window. 

The Outputs can be activated manually. One way is to use the switch with the 

red LED in the output sectio n. It activates the channel and shows that it is 

activated by its red light. The other way is to send a pulse to the output; this is 

a short signal that activates the device only for an instant. This can be done to 

check if the vacuum pump is running e.g. but wonõt work very well to find out 

if the stirrers are working properly.  
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12  Control File Visualization  

The Control File Visualization can be opened by the icon in the main windowõs 

Toolbar or in the Menu Bar via Visualization -> Control File Visualization.  

If running a time control file it is displayed as a table. All the rows that have 

already been performed will be displayed in red; all those rows that still have 

to be performed are displayed in blue. The blue field above the table shows 

the name of the ti me control file loaded.  

If running a sequence control file one can observe an additional table above 

the time control table. In this additional table the time control files and the 

assigned runtimes can be seen. The files that already have been performed a re 

red those still to perform are blue. In the additional yellow field at the top one 

can see which sequence control file has been loaded.  

 

Figure 38  

The each table scrolls itself so the actual step can always be seen.  
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13  Program Set tings  

The Setup Window can be opened by using the setup icon on the Toolbar or 

via the Menu B ar: File -> Setup  

WARNING: CHANGING SETTINGS IN THE SETUP OF THE SOFTWARE CAN HAVE GREAT IMPACT ON 

THE FUNCTION OF YOUR MACHINE. THE SETTINGS ARE NOT TO BE CHANGED UNLESS THE 

PERSON IS QUALIFIED FOR THIS TASK. 

The setup window has several tabs, the function of each will be described now 

one after the other.  

13.1  Communication  Tab  

 

Figure 39  (Setup Communication Tab)  

The Communication Tab is used  to configure the systemõs serial controlled 

interfaces and valves.  There are different sections in this tab that are taking 

care about different communication tasks.  
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13.1.1  MultiCom Interfaces  Section  

 

Figure 40  (Setup Communication Mul tiCom Section ) 

MultiCom Interfaces  Section  lists all the controllable interfaces who are 

communicating via a COM port that can be activated or deactivated in this area 

of the window (Figure 40 ). In the address column it can be  seen to which 

address the device is set. The Port column shows to which serial port the 

interface is connected.  

13.1.2  Syringes  

 

Figure 41  (Setup Communication Syringes Section) 

The Port column shows to which serial port the device is connected to.  The 

dispenser is also connected to COM ports. In the Syringe [µl] column the 

volume of the syringe is entered and the Type column needs to know the kind 

of dispenser sending the data  to.  

13.1.3  Valve Boards and Valves  

 

Figure 42  (Setup Communication Valve Boards and Valves Section ) 

In the right section  the serial controlled valves are managed. Number of valves  
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shows how many valves are to manage. Each valve has its own tab; the valves 

are operated by Valve Boards  that are managed in the upper area. One can see 

in the fab of the valve: the kind of valve and on which port on what board the 

valve is assigned to.  

The valves are grouped on boards, this way not all valves have to be plugged 

into the main board of the system but get remote connection boards that are 

linked into the systems bus.  

The Valve Boards are similarly configured; on the left in that area the thre e 

jumpers that are representi ng the address of the board in binary  code  can be 

seen. For better understanding there is also a decimal board number displayed 

depending on the configuration of the three jumper s.  A jumper can be 

changed from 1 to 0 or vice v ersa by clicking at and below the board number 

the board address is displayed. Beside the numbers and addressing the 

number of in - and outputs a valve board has , has to be specified . This can be 

different from board to board.  

After all these specifications  it  may be necessary to remove a valve assignment 

from a board or add a new one.  

Removing is easily done by clicking on an assigned port of a board (assigned 

ports are the impressed grey squares)   

 

Figure 43  

A query window opens to get a confi rmation that the assignemt should be 

deleted.  

If  such an assignement of a valve to a board  needs to be created,  this can be 

done by chosing the tab of the valve that has to be assigned. Click on the 

pointing hand icon beside the port and bo ard adresses. The mouse cursor 

changes in shape. Poninting on the actual boards ports above it showes the 

poining hand. Just click with the finger on the port you want to assign it to. 

The board number can easily be adjusted even while the mouse cursor is the 

pointing hand. One thing to take care of is that the port needs to be òexistingó 

before starting the assignment. If a board has only 4 outputs you cannot 

assign a valve to port no. 5, and you cannot change the number of output 

ports while having a poin ting hand mouse cursor.  

If you donõt want to assign anything but already clicked on the pointing hand, 

just go in an area where the mouse curser shows a not allowed symbol. If 

clicking  there the mous e cursor will turn to an òordinaryó one again. 
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Summary  

MultiCom Unterfaces  Select the peripheral instrumentation and the Com -

Port to that it is connected  

Valve Boards  If an I
2

C-bus -board is connecte, it can ve configured 

with the jumper positions. The jumpers allow to 

configure up to 8 I
2

C-bus -boards, each with up to 7 

valves.  

Valves Need to be assigned to a Board.  

Warning: if a valv e is assigned to more than one bo ard  it is possible that the 

valve is not working correctly, or the whole setup stops working  

Dispenser  Up to 4 dispenser can be controlled. If the 

dispernsers are connected to one serial port 

(system is then one master -syringe and all others 

are slave syringes) the syring assigned to adress 1 

is the master -syring, adresses 2 ð 4 are slave 

syringes. If there are several master syringes they 

all need t o be assigned to adress 1, but then the 

com -port has to differ. For each dispenser the 

syringe volume is defined.  

Digital Control Iputs  The control -functions Stop all, Time Control Start 

and Time Control Hold can ve selected and 

addressed. This allows exte rnal use of those 

functions.  
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13.2  Presets  

 

Figure 44  (Setup Presets Tab)  

The Presets Tab also has different areas to configure, the explanation will be 

given one by one.  

13.2.1  Major Pump System  

In the Major Pump System  area of the Presets tab (Figure 44 ) the standard and 

maximum values for the Primary Pump is set : 

Default Flow -rate:  the standard flow -rate set for the pump at the start of the 

program  

Max.  Flow -rate:  maximum flow -rate for the pump  

Max. Pressure:  maximum pressure, the pump will stop if reaching this 

pressure  

Serial Cycle:  time interval of status requests to the pump  

Valve Cycle:  time for a mix cycle of a low pressure gradient system at 

a flo w rate of 10ml/min  

Valve Min. Cycle:  minimum permitted switching rime for the gradient mix 

valves in use  

Max. Voltage:  maximum controlling voltage for voltage controlled 

pumps  




























